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Legal Notice 

This documentation was prepared by GE Energy (GE) as an account of the work 

sponsored by the participating companies listed in the Foreword. Neither the 

Sponsors, nor GE, nor the software subcontractor, nor any person acting on behalf of 

any of them: 

1. Makes any warranty or representation, express or implied, with respect 

to the accuracy, completeness, or usefulness of the information 

contained in this report, or that the use of any information, apparatus, 

methods, or process disclosed in this report may not infringe privately 

owned rights; or 

2. Assumes any liability with respect to the use of, or for damages 

resulting from the use of, any information, apparatus, methods, or 

process disclosed in this report. 

In accordance with the terms and conditions of the contracts between GE and the 

Sponsors, neither this report, nor any technical project results or guidelines may be 

disclosed to any company, utility, individual, or organization other than the Sponsors 

as listed in the Foreword of this report, without the written concurrence of the DSTAR 

Chairman. 
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Foreword 

This project was conducted by General Electric International, Inc. for a consortium of 

utility companies and utility organizations known as the Distribution Systems Testing, 

Application, and Research (DSTAR) group as part of DSTAR Program 13. The 

participating companies are: 

Ameren Corporation 
American Public power Association, DEED 
Duke Energy 
National Rural Electric Cooperative Association, CRN 
Progress Energy 
South Carolina Electric and Gas 
Southern Company 
We Energies 
Wisconsin Public Service Corporation 

This software development was performed by General Electric International, Inc. This 

project was performed under the guidance of a Project Review Committee whose 

membership is comprised by representatives of the companies listed above. This 

committee is responsible for both the Program 13 research and long-range goals of 

the DSTAR program. 
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Section 1 SEDS Overview 
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What is SEDS? 

Initially developed in 1998, the Secondary Electrical Design Software (SEDS) enables 

users to quickly layout a secondary design and easily assess performance measures 

such as voltage drop, flicker, loading and short circuit current using a customized load 

flow algorithm. SEDS includes load diversity in the calculations, and uses a 

sophisticated approach to calculating the coincident demand of dissimilar types or 

sizes of loads -- a situation which can give silly results using conventional coincidence 

tables. 

SEDS development benefited significantly from the testing, guidance, and input of the 

consortium member utilities. Development with such tight user integration resulted in 

a final product that provides significant flexibility and usability to the large number of 

utility planners all across the United States. 

SEDS performs a variety of calculations for both single-phase and three-phase 

systems: 

Single Phase Systems: 

• Distribution transformer coincident loading 

• Secondary cable loading coincident current 

• Secondary service voltages 

• Mutual and self-flicker 

• Service-entrance short circuit currents 

• Cold load pickup guidelines 

• Optimization based upon first cost or first order total owning cost 

Three Phase Systems: 

• Distribution transformer loading 

• Secondary cable loading 

• Secondary service voltages 

• Voltage unbalance 

• Mutual and self-flicker 

• Service-entrance short circuit currents 

The recently developed optimization algorithm uses a member utility’s existing SEDS 

database, and employs a unique method to improve overall computational time while 

always finding the best solution in a defined pragmatic space.  The optimization 

objective function can be set for lowest first cost or lowest total owning cost taking into 

account overall secondary system losses.  SEDS is the ideal software package for 

helping planners design the most efficient secondary systems using standard 
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equipment (transformers and secondary conductors) while meeting technical service 

requirements. 

Optimization 

The recently developed optimization algorithm uses a member utility’s existing SEDS 

database, and employs a unique method to improve overall computational time while 

always finding the best solution in a defined pragmatic space. The optimization 

objective function can be set for lowest first cost or lowest total owning cost taking into 

account overall secondary system losses. SEDS is the ideal software package for 

helping planners design the most efficient secondary systems using standard 

equipment (transformers and secondary conductors) while meeting technical service 

requirements. 

 

Figure 1-1 Optimization dialogue box 

Customization 

SEDS data selections are customizable, similar to the DSTAR Engineering Toolbox. The 

Administrator sets up the database with standard load types, cables, and 

transformers. Motor types for flicker calculations and coincidence factor categories 

can also be set up by the Administrator. The user can simply select on one of these 

standard types from the database, or directly input data. The administrator can also 

customize the images used for each component represented in SEDS. To save the user 

the effort of specifying equipment over and over again, SEDS provides a "data copy" 

function which transfers the specifications from one load or cable to another with a 

simple mouse click on the graphic object. 
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Figure 1-2 SEDS customization dialog boxes 

Designing Secondary Systems Using SEDS 

SEDS allows users to construct a secondary system design very quickly.  However, 

there are some basic engineering questions that need to be addressed before SEDS 

can perform the calculations necessary to evaluate and optimize a design. Some of the 

key engineering questions related to secondary system design are: 

• What is the steady-state and flicker characteristic of the connected loads? 



  SEDS Overview 

Secondary Electrical Design Software Application Guide   

Restricted Distribution – See Legal Notice  1–5 

• How long are the conductor runs? 

• Is the service overhead or underground? 

• What are allowable limits for flicker, voltage drop, and short circuit current? 

• What transformers and conductors are available? 

• Are losses going to be considered? 

• What is the first cost of each piece of equipment? 

• What is the single-phase coincident factor for the connected loads? 

After careful consideration of these key questions and populating the database with 

the relevant equipment data, users are ready to build a secondary system design. 

Users can build a base secondary design, similar to the example shown in Figure 1-3, 

by selecting components shown in the toolbar and dropping them on the screen in the 

desired location. Double-clicking the component and either selecting pre-populated 

data or entering user specified data specifies the attributes of the components.  Each 

DSTAR utility has developed its own set of pre-populated data for transformers, loads, 

and conductors. 

 

Figure 1-3 SEDS Sample Layout 
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Figure 1-4 shows an example of a secondary design with calculation results. In this 

example, there are no voltage drop or flicker violations. The voltage drop and flicker 

results are shown next to each of the loads in the design. SEDS shows color-coded 

results to indicate whether or not the user defined voltage drop or flicker warning 

criteria has been violated. Additionally, the user will be warned if the transformer or 

conductor is overloaded. If there are violations, the user can make adjustments to the 

design to remove violations. Alternatively, the user can use the optimization feature in 

SEDS to remove violations while minimizing cost. 

 

Figure 1-4 SEDS Sample Results Screen 

  



  SEDS Overview 

Secondary Electrical Design Software Application Guide   

Restricted Distribution – See Legal Notice  1–7 

Capabilities of SEDS 

Single Phase 

The SEDS Single Phase mode is limited to radial, single-phase secondary distribution 

systems. SEDS can accommodate up to one hundred loads and up to twenty-five tiers. 

Figure 1-5 illustrates the definition of a load tier. 

SEDS is limited to 120/240 V secondaries, and handles both unbalanced and balanced 

single phase loads connected phase-to-phase or phase-to-neutral. It is rarely 

necessary to perform calculations assuming unbalanced single-phase loads, but this 

capability exists in SEDS. 

 
Figure 1-5 Example of a load tier 

Three Phase 

The SEDS Three Phase mode is limited to radial, three-phase secondary distribution 

systems. SEDS can accommodate up to one hundred loads and up to twenty-five tiers. 

Figure 1-5 illustrates the definition of a load tier. 
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SEDS Structure 

The program opens to a main menu where the user is presented with the three main 

areas of the program; Single Phase Design, Three Phase Design, and Database Utilities.  

 

Figure 1-6 SEDS main menu 

Both the Single and Three Phase areas open to the Design Tab. All entry and changes 

of system data are performed on this tab. Switching to any of the other tabs causes 

system calculations to be performed. A valid system must be entered before switching 

to the calculations tabs, which are: 

• Voltage 

• Flicker 

• Short-Circuit 

• Detailed Results 

In the Database Utilities area the Program Administrator has access to customized 

parameters that are available for convenient selection by the user. The customized 

data for Single Phase SEDS are below. Three Phase SEDS only has the first three. 

• Transformer parameters 

• Standard load data 

• Secondary cable data  

• Motor starting current characteristics 

• Load coincidence factors 

• End user Equipment data 

The customized data are maintained in a database structure that is accessible only 

with the appropriate password. 
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What’s New in SEDS V4.2 

Seasonal Coincidence Factors 

The SEDS database has been modified to allow storage and retrieval of seasonal 

coincidence factors for single phase loads, and the logic and output are also updated 

accordingly. The Coincidence Data entry form can be accessed using the Edit Custom 

Parameters menu item after the database is unlocked with the correct password (see 

Database Utilities in Section 3). The original data Coincidence Data entry form and the 

new Coincidence Data entry form for V4.2 are shown in Figure 1-6. 

   

Original Data Entry Form                                  New Data Entry Form 

Figure 1-7 Original (V4.1) and new (V4.2) coincidence data entry forms 

Store and Retrieve Three-Phase Loads 

The SEDS database has been modified to allow storage and retrieval of three-phase 

load data, and the logic and output are also updated accordingly. The Three-Phase 

Load Data entry form for the equipment database can be accessed using the Edit 

Custom Parameters menu item after the database is unlocked with the correct 

password (see the Database Utilities subsection of Section 2). In V4.2, there is now a 

menu item for Loads, as shown in Figure 1-8. 
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Figure 1-8 Data entry selections for three-phase SEDS V4.2 

When Edit Custom Parameters  Loads is selected, the new Load Data entry form for 

the SEDS equipment database is shown (see Figure 1-9). 

 

Figure 1-9 New load data entry form for three-phase SEDS V4.2 

The new form allows users to define parameters for three-phase loads and save them 

in the equipment database for retrieval. Loads can be defined as a combination of 
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balanced and unbalanced phase-to-neutral (wye connected) and phase-to-phase 

(delta connected) loads. Summer and Winter KVA and PF can be specified. In addition, 

the largest motor load can be specified (for short-circuit and flicker calculations) and 

the total motor running load can be specified (for use in steady state calculations). 

Once loads have been added to the SEDS equipment database, they can be added to 

any load in SEDS. Double-click on a load object to open the window shown in Figure 

1-10. This window will set the parameters for the selected load. The parameters of 

each load object need to be selected from the loads stored in the SEDS equipment 

database and modified in this window if needed.  

 

Figure 1-10 Updated load data input window for three-phase SEDS V4.2 
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In addition, end-use equipment such as (freezers and stoves) that are defined as being 

three-phase in the equipment database can also be added to the three-phase loads in 

this window (as shown in Figure 1-10). Note that to edit or add equipment, you have to 

switch to Single-Phase SEDS and chose Edit Custom Parameters  Equipment. More 

information on entering three-phase load data is available in the Load Parameters 

subsection of Section 7. 
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Section 2 Installing SEDS 
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System Requirements 

The DSTAR Secondary Electrical Design Software (SEDS) program is designed to run on 

Windows 2000, Windows XP and Windows 7. 

In addition to the minimum requirements of the operating system, SEDS requires 

approximately ninety megabytes (MB) for the program files and dependencies, and a 

screen resolution of at least 1024x768 for best results. 

Installation Instructions 

The DSTAR Secondary Electrical Design Software (SEDS) program is contained in a 

compressed installation file distributed via the DSTAR web site (www.dstar.org) or from 

your company intranet site. An automatic installation utility will install SEDS onto your 

computer. Installation should take only a few minutes. 

NOTE: The latest version of SEDS is version 4.2.0. If you have the previous version (4.1.0) 

installed, you can either uninstall it and install SEDS 4.2.0 or retain it and install SEDS 

4.2.0 in a different location. The steps are as follows: 

1. Download and Run the SEDS 4.2.0 installation package. It may be named 

SEDSSetup-4.2.0.0.exe, or SEDSSetup-4.2.0.0_Trial.exe or SEDSSetup-

4.2.0.0_Beta.exe, or something similar. You should a welcome screen similar to 

the one below. Click Next. 

 

http://www.dstar.org/
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2. The next screen is the standard License Agreement shown below. Read in its 

entirety and click I Agree or Cancel.  

 
 

3. If you accept the licensing terms, the third screen shown below will ask to 

choose an install location. The default is shown below. You can accept this 

default if you uninstalled your previous version of SEDS or change to another 

location such …\DSTAR\SEDS 4.2 if you wish to keep the old version. Click Next. 
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4. On the next screen, make sure that Full Sample Database is checked (see 

below). Click Next. 

 

5. The final screen allows you to specify a start menu shortcut. If you have an 

older version of SEDS installed, it is recommended that you modify the Start 

Menu entry, as shown below. Click Install to complete the installation. 
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You can now run SEDS V4.2 by double-clicking on SECONDARY.exe file in the 

installation folder, or using the shortcut on your start menu. If you encounter an error 

during installation or when you run SEDS, please contact your DSTAR representative for 

assistance or send an email to dstar-support@dstar.org.  

mailto:dstar-support@dstar.org
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Section 3 Launching SEDS 
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This section of the SEDS Application Guide provides instructions for starting the SEDS 

application. This section will cover the Main Menu (SEDS: Design Selection) and the 

Database Utilities. 

Opening the Program 

When you first launch SEDS, it opens to the Main Menu or Design Selection window 

shown below in Figure 3-1. The main menu window allows the user to select from the 

three main areas of SEDS: Single Phase Secondary Systems, Three Phase Secondary 

Systems, and Database Utilities.  

 
Figure 3-1 SEDS main menu window 

NOTE: The latest version of SEDS V4.2 includes some changes to database structure so 

old databases (.mdb files) will not work with SEDS 4.2. They will have to be converted, 

which is a manual process for now. In order to convert an old database to the latest 

format, please contact your local DSTAR representative and ask them to contact GE 

Energy. GE Energy will update the database to the latest structure. 

Single Phase Secondary Systems 

Clicking on this button will launch the Single Phase application of SEDS. This requires a 

valid connection to a single phase SEDS database. Section 4, Inputting Single Phase 

Data has further information and instructions for using the single phase application. If 

a valid connection does not exist then you will be prompted to use the Database 

Utilities function to establish a valid connection (see Database Utilities subsection). 
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Three Phase Secondary Systems 

Clicking on this button will launch the Three Phase application of SEDS. This requires a 

valid connection to a three phase SEDS database. Section 7, Inputting Three Phase 

Data has further information and instructions for using the three phase application. If a 

valid connection does not exist then you will be prompted to use the Database Utilities 

function to establish a valid connection or convert a single phase database to three 

phase (see Database Utilities subsection). 

Remember This Selection 

This option will allow you to launch SEDS directly into your preferred mode, skipping 

this screen on startup. To use this feature, select this check box before entering either 

Single Phase or Three Phase mode. Next time SEDS is started, it will go directly into the 

selected mode. To return to this main menu, select File  Main Menu from either 

mode. 

Database Utilities 

SEDS provides a database utilities feature that allows the user to easily maintain, 

manage, and convert SEDS input data. The Database Utilities feature opens to the 

window shown in Figure 3-2. 

 

Figure 3-2 Database Utilities Window 

This window allows the user two basic functions: 

• Maintain user input data 

• Maintain the database connection path 

When finished using the utilities, a click of the OK button will close the Database 

Utilities window and display the Design Selection main menu. 

See Section 10 Program Administrator Information for more on maintaining the 

database. 
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Maintaining the Database Connection 

The path of the current database is shown when the Database Utilities window opens. 

This can be changed by either editing the path and filename or by clicking the 

Browse… button. The Browse… button allows the user to select a database file by 

using a Windows Explorer dialog box. Any change in the database connection path will 

be discarded if the Cancel button is used to close the Database Utilities window. 

CAUTION! - The user must be careful when changing databases and loading previously 

saved projects. If a saved project is loaded while using a connection to a different 

database than the one that was used to create the project, the solutions will be 

unreliable. SEDS will warn the user if the saved project appears to be inconsistent with 

the loaded database. Extreme care must be taken to ensure that the saved project 

data is consistent with expectations. 

 
Figure 3-3 User warning if database is inconsistent with saved file. 
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Section 4 Inputting Single Phase Data 
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This section of the SEDS Application Guide provides step-by-step instructions for 

inputting data for an example single phase system. SEDS is a very easy to use 

program, and following through this example will provide you with sufficient familiarity 

to set up and run your own cases. 

Opening the Program 

SEDS opens to the Design Tab window shown below in Figure 4-1. The Design Tab is a 

drawing tablet where all the system components are graphically added and their 

parameters (properties) are set. The other tabs (Voltage, Flicker, Short-Circuit, and 

Detailed Results) are selected to reveal calculation results, after the circuit design has 

been entered. 

 

Figure 4-1 SEDS Design Tab Window 

Inputting the Circuit Configuration 

The first step of inputting case data in SEDS is to draw the secondary system 

configuration. On the Design Tab is the object toolbar, shown on the top right side of 

Figure 4-1, which has buttons for each circuit element plus a button for copying 
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properties (parameters) of the elements and creating freeform text boxes. Only one of 

these buttons can be selected at a time. 

Placing the Transformer and Primary Source Objects 

Circuit configuration input begins by placing the distribution transformer on the 

drawing tablet. Select either UG Trans or OH Trans by clicking the appropriate button. 

Now, using the mouse, click on the location on the drawing tablet where the symbol 

(object) for the transformer is desired to be placed. Hold down the left mouse button 

and drag the mouse slightly, then release. Symbolic objects representing the 

transformer and its primary source will appear on the tablet as illustrated in Figure 4-2. 

 

Figure 4-2 Padmount transformer and primary source object placed on the tablet. 

The primary source and the transformer objects can be moved together to a new 

location on the tablet by clicking on the source symbolic object (three parallel lines) 

once, and then pressing the mouse button again and holding the button down while 

dragging the source and transformer to the new location. Clicking and dragging the 

transformer object in a similar manner will move the transformer object alone while 

keeping it connected to the source symbol. 

Note that the transformer background is initially red in color. This indicates that 

transformer parameters have not yet been selected. Later when the parameters have 

been entered, the background turns white. 

Inserting Nodes 

Connection points where two or more secondary cables come together (other than at 

the transformer) are called nodes. Nodes can represent a secondary pedestal or a pole 

where several secondary service cables connect to the secondary main. Nodes can 

also be used for transition points where the secondary cable size or type changes, or 

for transition between overhead and underground secondaries. 

Primary 
Source 

Padmount 
Transformer 
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The next step to laying out the secondary configuration is placing nodes (if any) on the 

tablet. In the object toolbar, select the button for Node. Now place the node object 

onto the drawing tablet by holding down the mouse button and dragging at the 

desired location. Repeat click and drag for any other nodes. Figure 4-3 illustrates two 

nodes added to the example circuit layout. 

 

Figure 4-3 Two nodes added to the circuit. 

Adding Loads 

The secondary circuit needs to have at least one load. Load objects are placed on the 

tablet by first selecting Load in the object toolbar. Click and drag on the tablet in the 

desired location for each load. Note that the secondary cable interconnections 

between the transformer, nodes, and loads are added in the next step. The load object 

color is initially red, indicating that the parameters of the load have not yet been 

entered. Figure 4-4 shows five loads added to the example circuit. 

 

Figure 4-4 Example circuit with five loads placed. 



  Inputting Single Phase Data 

Secondary Electrical Design Software Application Guide   

Restricted Distribution – See Legal Notice  4–26 

Adding Secondary Cables 

Secondary cables (overhead or underground) are added to the circuit in a different way 

than the transformer, nodes, and loads are placed. First, select Cable from the object 

toolbar. Next select the beginning point (upstream end) of the first cable by clicking the 

object to which it is connected (e.g., the distribution transformer object). Now click the 

end point object of the same cable. If, after clicking the beginning point object, a 

different beginning point object is desired, select a different object on the toolbar and 

then re-select Cable. The next object selected will be a cable beginning point, instead 

of an end point. 

In our example, cables have been placed connecting the transformer to the two 

secondary pedestals (nodes) and to the load in the upper right. Cables have also been 

placed from the pedestals to two loads each. The configuration of the example is 

illustrated in Figure 4-5. Note that the cable objects appear as broken lines, indicating 

that their parameters have not yet been specified. 

 

Figure 4-5 Transformer, nodes, and loads interconnected by cables. 

There are limitations to the placement of secondary cables: 

• Only one cable can have its end point on a given object. This prohibits closing a 

secondary loop, and also prohibits parallel cables. (Secondary circuits with parallel 

cables can be analyzed by representing the parallel cables as one equivalent cable, 

with an impedance equal to the parallel combination. 

• Only the beginning end of cables can be connected to the distribution transformer 

object. 
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• Only the downstream ends of cables can connect to a load. You cannot connect a 

cable from one load to another. If the actual circuit has the secondary cable 

connecting to one load and then continuing on to another, then terminate the 

incoming cable before the first load at a fictitious node, and insert a very short 

cable between that load and the first load. The cable from the first to second load 

in the actual system is represented in SEDS by a cable between the fictitious node 

and the second load. 

Order of Object Placement 

In the example shown above, the objects were placed in the order of transformer, 

nodes, loads, and cable. It is necessary to begin with placing the transformer, and 

cables must connect existing objects. Otherwise, the order of object placement is 

arbitrary. For example, the configuration shown in Figure 4-5 could be fully assembled 

and then a new node and load added, connected by new cable sections. 

Drawing Over a Graphic Image 

A useful feature of SEDS is that it allows the secondary circuit to be drawn on top of 

another graphic image, such as a development plat showing home and transformer 

locations. Figure 4-6 illustrates this capability. 

 

Figure 4-6 Development plat loaded as a SEDS background image. 

To insert the background image, click the View → Insert Back Picture menu item, and 

select the desired image file. The background image must be in bitmap, Windows 
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metafile, or enhanced metafile formats. The background image can also be removed 

by clicking View → Remove Back Picture. 

Creating Captions 

Free form text can be added to the tablet at any time by selecting the Caption button 

from the toolbar. To create a caption, click and drag a box the approximate area and 

size desired. 

 

Figure 4-7 Caption Editor window that is displayed after creating a caption 

After releasing the mouse button, the window shown in Figure 4-7 will appear. This is 

where you enter the text to display and also select the font and background color. The 

text color is set in the font dialog. To set a transparent background, set the background 

color to black. 

Detailed Design View 

The detailed design view (View  Detailed Design) allows the user to view, at a glance, 

the length of cables and the description of the loads, as shown in Figure 4-8. 
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Figure 4-8 Showing the design tab in detailed view. 

Specifying Object Parameters 

Object parameters are set by double-clicking on the object to open its data entry form. 

It is also possible to copy properties from one object to another similar object (e.g., 

from a load to a load or a cable to a cable). This will be described later. 

Equipment parameters in SEDS are set by selecting from a pre-existing list, or by 

directly entering the data. The pre-existing lists in SEDS can be set up by your 

company’s SEDS Program Administrator, based on materials and practices used by 

your company. These lists are maintained in a separate password-protected area of 

SEDS (see Database Utilities). 

Some users may want to uniquely identify loads and nodes for viewing purposes. Users 

can assign special identifiers to nodes and loads by clicking on Edit Custom 

Parameters  Node and Load Prefixes. The window shown in Figure 4-9 allows users 

to edit the prefix used for various items shown in design mode. The Preview field shows 

an example of how the actual assignment will look in the design mode. This is a useful 

feature for labeling items consistent with the normal nomenclature used in your utility. 
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Figure 4-9 Node and Load Prefix Settings. 

Source Parameters 

Optionally, the primary source impedance can be included in SEDS calculations of 

flicker and short-circuit currents. Primary impedance is never included in SEDS steady-

state voltage drop calculations. 

The SEDS default is to ignore primary-side impedance in flicker and short-circuit 

calculations, which is the same as assuming that the primary side of the distribution 

transformer is connected to an infinite bus. 

To include primary feeder impedance in flicker and short-circuit calculations, double 

click on the primary source object to open the window shown in Figure 4-10. 

 

Figure 4-10 Primary source impedance data window. 
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Click the button marked Consider primary source impedance. Next select the nominal 

voltage applied to the primary winding. If the transformer is connected phase-to-

neutral, then the input must be the phase-to-neutral voltage (e.g., 7.2 kV). If the 

transformer is connected phase-to-phase, then the input voltage is the phase-to-

phase voltage (e.g., 12.47 kV). Input the available short-circuit current at the 

transformer primary terminals, in Amperes. This short-circuit current should be the 

available current if the transformer primary winding is short circuited. Thus, the 

appropriate short-circuit current for a phase-neutral (wye) connected transformer is 

the phase-ground fault current, and the input short-circuit current for a phase-to-

phase (delta) connected transformer is the available phase-to-phase fault current. 

Enter the ratio of inductive reactance to resistance (X/R ratio) for the primary system. 

For a phase-to-neutral connected transformer, the X/R ratio should be that of the 

phase-to-neutral current path impedance (one-third of the sum of the positive, 

negative, and zero-sequence source impedances). Typical overhead primary systems 

have an X/R ratio in the range of 0.5 to 10, and typical underground primary system 

X/R ratios range from 0.3 to 3. After entering and selecting the source object 

parameters, click OK. Clicking Cancel closes the primary source data window without 

executing the inputs provided. Chose Save As Defaults if you want SEDS to remember 

and use these parameters as the defaults for flicker and short circuit calculations. 

Transformer Parameters 

Double-click on the transformer object to open the window shown in Figure 4-11. The 

list box in the middle of the window all padmount transformers (if the transformer 

object placed on the tablet is a padmount transformer), or all polemount transformers 

(if that type was placed), for which your company’s SEDS Program Administrator has 

provided data (or the default transformers included in the sample database, if that 

database is associated with SEDS). One of these transformers may be selected. If so, 

that transformer’s parameters will show below the selection list. 

The transformer list can be filtered by using the selection boxes at the top of the 

Transformer Data window. The default filtering selection is an asterisk (*), meaning 

“wild card,” or unrestricted by that category. There are four categories of filtering: kVA 

rating, primary winding voltage, “type,” and polemount /padmount. Selection of a 

parameter in a category will limit transformers shown in the list box to those having 

the same parameter for that category. The “type” category can be used for various 

purposes, depending how the company SEDS Program Administrator sets it up. For 

example, it can be used to indicate special transformer features such as CSP or fusing 

options. The filtering selection for each category can be reset to the wild card value by 
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clicking the appropriate Reset button. All categories can be reset using the Reset All 

button. 

If the transformer to be studied is not available on the equipment list, then the user can 

enter the transformer data directly by clicking on the check box marked User Specified 

Transformer Parameters. The transformer impedance (%Z) and resistance (%R) are in 

percent of the impedance base for the selected nameplate kVA rating. Resistance may 

not exceed the total transformer impedance. Enter the maximum summer and winter 

loading capability of the transformer, based on your company’s loading practices. 

Typically, these maximum loadings exceed the nameplate kVA. 

After all entries are complete, click OK to assign the parameters to the transformer 

object. 

 

Figure 4-11 Transformer data input window. 
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Cable Parameters 

Double-click on any cable object to open the window shown in Figure 4-12 for 

specifying the parameters of that cable. A selection list of cables is shown in this 

window. This list is maintained by your company SEDS Program Administrator in the 

equipment database, and should contain the service cable types and sizes that your 

company uses. Clicking the Overhead or Underground radio buttons at the top of the 

window causes the cable list to show only that category of conductor. 

Selection of a cable in the listbox on the right causes the resistance and reactance per 

1000’ of that cable to be shown in the fields on the left, as well as the summer and 

winter cable ampacity. After selecting the desired cable type, enter the length of the 

particular cable section in feet and click OK. The parameters of each cable object need 

to be set in this manner, or by using the Properties button described later. 

NOTE: The cable length entered for single phase systems is the one-way length, not the 

round-trip length of the conductor. SEDS doubles the impedance/length of the cable to 

account for the voltage drop in the neutral. 

 

Figure 4-12 Cable data input window. 
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Load Parameters 

Double-click on any load object to open the Load Data window shown in Figure 4-13. 

This window will set the parameters for the selected load. The parameters of each load 

object need to be set using the procedure described below, or load parameters can be 

copied from one load to another using the Copy Properties function (explained later). 

SEDS assigns a default name for the load, depending on which node the load is 

connected to. This is shown in the Load Name box at the top of the load data window. 

By default the pattern N2L1 is used, which indicates the first load (in order of entry) 

connected to the second node (in order of entry). This pattern can be changed and will 

be discussed later. If the load is supplied directly from the transformer secondary 

without an intervening node, the default name will begin with S instead of N#. 

Optionally, the user can provide a descriptive name for the load, such as the house 

number or meter number. The user-supplied name is entered by overwriting the 

default name in the load data window. The load name appears on the circuit 

configuration drawing, and in the results reports. 

 

Figure 4-13 Load data input window. 
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If the Database Loads button is pressed, the load data window will display a drop-

down list of standard single-phase load types. Your company’s SEDS Program 

Administrator maintains this list in the SEDS equipment database. Assigned to each of 

these loads are summer and winter peak values, power factors, coincidence factor 

category, and starting-current data for any critical motor load associated with that 

load type. Selecting a database load from the drop-down list causes the parameters of 

that load type to populate the data fields below the list box. Click OK to assign the 

standard database load parameters to the selected load object. 

Alternatively, the user can enter load data directly by clicking the User Specified Loads 

button. SEDS would now display fields for the user to enter Summer and Winter KW 

and power factor, and coincidence as shown in Figure 4-14. Coincidence is the load 

classification with respect to the coincidence factors used for voltage drop, 

transformer loading, and secondary cable current calculations. The descriptions of the 

coincidence classes, and the factors used, are established and maintained by your 

company’s SEDS Program Administrator in the SEDS equipment database. The user 

can also click the Transfer from Database Loads button to transfer the parameters of 

a selected database load to the user specified parameters fields to be modified. 

 

Figure 4-14 Partial load data input window showing user specified parameters 

In addition to the standard list of single-phase loads, your company’s SEDS Program 

Administrator may have included a set of equipment to build your own composite load. 

By clicking the checkbox next to the Equipment label and choosing Add Equipment, a 

new blank row will added to the equipment list. This is shown in Figure 4-13. To select 

the equipment to add, simply click in the cell with the description label and select the 

equipment from the drop-down list provided. It should be noted that this equipment will 

be ADDED to the other steady state selected loads. The Total Load listed will be updated 

after selection and addition of equipment. 

Flicker calculations require the largest transient current to be specified for each load. 

Usually, this transient current is the starting current for a relatively large motor, such 
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as a central air conditioner compressor. The starting current may be included in the 

standard load type, or it may be directly entered by the user. To directly input motor 

starting current (or any other transient current such as a welder, etc.), click on User 

Specified Motor. The user has a choice of the three following ways to input the current. 

1. The first option is to click Database Motor, and then select a description of the load 

from the selection list. Your company’s SEDS Program Administrator maintains this 

list in the SEDS equipment database. Associated with each type is a starting current 

and starting power factor, which show in the fields below the selection list when 

this input option is used. This is shown at the bottom on the load data window in 

Figure 4-13. 

2. The second option is to click Starting Amps/PF and input the motor starting 

current and starting power factor directly. This option can be particularly useful for 

a non-motor load which cause flicker, such as a welder. This is shown in the partial 

load data window below. 

 

Figure 4-15 Partial load data input window showing motor starting amps and PF option 

3. The third option is to click HP/PF/Code. Motor horsepower and starting power 

factor is input and the NEMA rotor code for the motor is selected. 

 

Figure 4-16 Partial load data input window showing motor HP/PF/Code option 

NOTE: The starting currents specified are used only for flicker calculations. The motor 

running load should be included in the total steady-state load. Transient current (i.e., 

motor starting current) data are not mandatory. If there is no transient current data 

provided for a load, the voltage flicker calculated will be the worst flicker caused by 

transient currents drawn by another load fed from the same transformer. If no 

transient loads at all are specified for the secondary system, the calculated self-

induced flicker will be zero. 
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After selecting or specifying load parameters, click OK to assign the parameters to the 

selected load. Repeat for all of the loads, or use the Copy Properties function 

described below. 

Copying Properties 

The Copy Props. button can be used to copy parameters from one cable to another, or 

from one load to another. To use this function, select Copy Props. on the object 

toolbar. Select the object from which the parameters are to be copied. Next, select the 

object (must be of the same type: cable or load) to which the parameters are to be 

copied. 

If cable parameters are being copied, SEDS will prompt the user for the length of the 

cable section to which parameters are being copied. (In essence, SEDS allows the type 

of cable to be transferred, but not the section length). 

The “copy to” process can be repeated multiple times without performing another 

“copy from.” If another object is desired to be the “copy from” object, click a different 

button on the object toolbar (such as Select) to reset the copy function and then click 

the Copy Props. Button again. 

NOTE: Choosing the Copy Props. button then double clicking a load will copy the 

properties of that load to all loads on the tablet. 

Checking Transformer Size 

After transformer and load parameters have been set, SEDS can check to ensure that 

the selected transformer rating is appropriate for the load. SEDS calculates the 

coincident peak summer and winter demands of the loads, and compares this to the 

load rating ranges for the transformer. The upper limit of the summer and winter load 

ranges for the transformer are provided in the transformer object properties. The lower 

load range limits are the upper limits of the next smaller size transformer in the SEDS 

database having the same winding voltage and type attributes. The SEDS database is 

set up and maintained by your company’s SEDS Program Administrator. 

To perform a check of transformer size, click the Check Transformer Size button to the 

left of the toolbar on the Design Tab window. If the coincident load is within the range 

for this transformer, a status box will appear at the bottom of the design tab with black 

lettering which summarizes the peak coincident loads, the net coincidence factors, and 

the transformer summer and winter load ranges. An example of this box is shown in 

Figure 4-17. Where the demand or type of individual loads on a secondary system 

differ from each other, SEDS uses a sophisticated approach to derive a net coincidence 

factor, which is described in Section 9. 
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Figure 4-17 Status box result when coincident peak demand and cold load pickup are within tx load range 

If the transformer is undersized, the transformer results that are out of bounds are 

displayed in red as shown in Figure 4-19. Also, the prompt shown in Figure 4-18 is 

shown on the screen. If the user selects "Yes", a list of alternative transformers with the 

appropriate voltage and type attributes is displayed, such as shown in Figure 4-20. 

Selecting a transformer, and clicking Accept, will replace the previous transformer 

selection with the new parameters. 

 

Figure 4-18 User prompt if selected transformer is overloaded. 

 

Figure 4-19 Status box result when summer coincident peak load exceeds the transformer’s range. 

 

Figure 4-20 Example list of suggested alternative transformers. 

If the transformer is oversized, meaning the next smaller transformer size can 

accommodate the coincident peak demand, the prompt shown in Figure 4-21 will be 

displayed. By clicking Yes, a list of alternative transformers, having the same voltage 

and type attributes, will be shown (similar to Figure 4-20). Selecting one of these 

transformers, and clicking Accept, will replace the previous transformer selection with 

the new parameters 
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Figure 4-21 User prompt if selected transformer is under loaded. 

Checking Conductor Size 

After transformer, conductor, and load parameters have been set, SEDS can check to 

ensure that the selected conductor current rating is appropriate for the load. Figure 

4-22 shows a system design where one of the conductors is overloaded. The button 

next to the Optimization button located in the lower right corner of the window 

indicates “1 overloaded conductor” and is available to be clicked. If there are no 

overloaded conductors, then this button will not be shown. 

 

Figure 4-22 Voltage results showing overloaded conductor 

Clicking the “Overloaded Conductor” button will display the window shown in Figure 

4.20. From this window, the user may select the appropriate underground or overhead 

conductor based upon the loading calculated by SEDS. The user highlights the 

conductor from the list of available conductors and then clicks the Apply Change 

button to change to the selected conductor. After finishing the selection, click the OK 

button to close the window and return to the results window. 
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Figure 4-23 Voltage results showing overloaded conductor 

Deleting Objects 

To delete load, node, cable, and caption objects on the design template, click on the 

object and press Delete on the computer keyboard. Be sure not to leave any 

“stranded” loads or nodes. Load deletion can cause the automatic load naming 

function to assign the same name to multiple loads. This can be overcome by 

providing a user-specified load name. SEDS will not allow you to delete a transformer. 

Saving and Loading SEDS Data 

SEDS allows saving of case data, and loading of saved case data using standard 

Windows commands such as Save, Save As, and Open on the File menu. SEDS cases 

are saved with the file extension *.flw. Note that the parameters for cables, 

transformers (other than user-defined), and standard loads are contained in a separate 
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SEDS database maintained by your company’s SEDS Program Administrator. An 

individual saved case contains references to this database. Any changes to 

parameters stored in the database can cause calculation results in a retrieved saved 

case to differ from the results obtained before database modification. To get reliable 

results from a saved case, the appropriate equipment database must be associated 

with SEDS when the case is loaded. SEDS will give a warning if they are not consistent. 

Use the Database Utilities button on the Main Menu to change the equipment 

database (see the Database Utilities subsection in Section 3, Launching SEDS). 
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Section 5 Obtaining Single Phase Results 
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Information about each of the objects on the design palette can be seen in the 

information box located at the bottom left of the application window by moving the 

mouse pointer over the desired object. An example of the mouse-over feature when 

hovering over a cable while on the Design tab is shown in Figure 5-1. 

 

Figure 5-1 Example of Information Box using the mouse-over feature 

After completing input of the secondary system configuration and parameters, SEDS 

performs calculations automatically when any of the output tabs (Voltage, Flicker, 

Short Circuit, or Detailed Results) are selected. Results are shown directly on the circuit 

diagram for each of these tabs. A printed summary of results can also be obtained 

from SEDS, as explained later in this section. 

Voltage Tab 

Clicking the Voltage tab displays steady-state results for the system. An example is 

shown in Figure 5-2. Summer peak conditions are shown when SEDS is switched to the 

Voltage tab. Winter peak conditions can be displayed by clicking the button marked 

Show Winter. Summer peak conditions can be shown again by clicking Show Summer. 

 

Figure 5-2 Example voltage tab display 
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Transformer Loading Results 

A box on the screen shows a summary of distribution transformer results. This includes 

summer and winter peak coincident load, as well as the transformer’s maximum load 

per your company’s loading guidelines. A net coincidence factor is shown, which is the 

ratio of the coincident peak demand on the transformer divided by the sum of the 

individual peak demands of all the loads. SEDS uses an approach to determining net 

coincidence factors that is explained in Section 5. The transformer results also include 

the peak load current at the transformer secondary terminals (summer or winter, 

depending on the voltage drop tab display mode), as well as the secondary terminal 

voltage at peak demand. 

The transformer loading results will display in red text if the selected transformer is 

overloaded in either summer or winter seasons. Also, text is displayed indicating the 

season in which the overload occurs. 

Secondary Cable Currents 

The peak coincident current flow is shown for each secondary cable section for the 

selected season. Note that this is the predicted peak current for that section, and is not 

necessarily the current in that section at the instant that the overall secondary system 

is at its peak. Thus, current into a node does not equal the sum of the currents out of 

the node, unless the coincidence factors for all loads are 1.0. 

SEDS compares the secondary cable peak coincident load with the cable rating, for the 

chosen season. If the cable current exceeds the ampacity limit, the cable will be 

displayed as a thick red line on the diagram. 

Service Entrance Voltages 

Service-entrance voltages at peak demand for the selected season are shown on the 

graphic circuit diagram. The user has the option of displaying voltage results on three 

different bases: a 120 V nominal base (although SEDS does not calculate separate 

voltage drops for each of the two 120 V legs at each load), a 240 V nominal base, and 

in terms of percent voltage drop with respect to the nominal 240/120 nominal voltage. 

To change the voltage display mode, choose the appropriate base in the voltage 

selection box located to the right of the Short-Circuit tab. Note that this selection also 

changes the mode of voltage display in the transformer results box. 

If the voltage drop at a load exceeds a limit, the voltage is displayed in red text. The 

warning threshold can be set via the Edit Custom Parameters  Warning Criteria 

menu. 
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Flicker Tab 

Switching to the Flicker tab will display voltage change caused by the transient loads, 

such as motor starting. An example is shown in Figure 5-3. Note that the total transient 

voltage regulation is the sum of the transient voltage change (flicker) and any steady-

state voltage drop present at that time. Customer irritation from transient load 

changes is a function of the relative change in light output, and not the minimum 

absolute voltage present during the event. Thus, the Flicker tab displays only the 

transient voltage change. 

 

Figure 5-3 Example flicker calculation results. 

When SEDS is switched to the Flicker tab, the display shows percent voltage change at 

service entrances due to transient loads at that service only. This is termed self-

induced flicker. The effects of a transient load at one service on flicker voltages at 

another can also be displayed by clicking the button on the upper right of the window 

marked Show Mutual. There are two options for the mutual flicker display. The option 

marked Include Self (the default option), displays shows the worst-case flicker from 

loads anywhere on the system, including flicker caused by loads at the same service. 

The second option, Exclude Self, shows only the greatest mutual flicker at each service 

as a result of transient loads at another service. Some utilities have different flicker 

thresholds for a customer’s flicker caused by his own load, and the allowed flicker due 
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to the customer’s neighbors. The Exclude Self option allows both types of flicker to be 

viewed. All of the mutual flicker output includes an indication of the load responsible 

for the worst-case flicker that is shown. 

If any load is subject to a voltage flicker magnitude greater than a specified threshold, 

the flicker magnitude is displayed in red text. The warning threshold can be set via the 

Edit Custom Parameters  Warning Criteria menu. 

A box on the flicker tab window displays the worst-case flicker at the secondary 

terminals of the transformer. This display also indicates the load responsible for the 

flicker. If this flicker is greater than a specified flicker criterion, red text is displayed. The 

flicker magnitude warning threshold for the transformer secondary voltage is separate 

from the load flicker warning threshold. 

Short Circuit Tab 

Switching to the Short Circuit tab will cause SEDS to calculate and display the available 

short-circuit currents at the service entrances and the transformer secondary 

terminals. Figure 5-4 shows an example. Any short-circuit currents greater than a 

specified threshold is displayed in red text. The warning threshold can be set via the 

Edit Custom Parameters  Warning Criteria menu. 

 

Figure 5-4 Example short circuit calculation results. 
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Detailed Results Tab 

The detailed results tab will show the results from both the voltage tab and the flicker 

tab, on one sheet. The first time that this tab is accessed, the dialog shown in Figure 

5-5 will be displayed for the user. This dialog is a combination of the options for both 

tabs, plus a “Worst Case” option for the season. This option will calculate results for 

both seasons and display the worst. 

 

Figure 5-5 Detailed Results Setup Dialog. 

Figure 5-6 shows the detailed results tab. The text next to each cable shows the cable 

type and the length of that section.  

 

Figure 5-6 Detailed Results Tab. 
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Each load displays the following information: 

• Load Description from the Load Parameters dialog 

• Voltage Drop. If “Worst Case” is selected for the season, this is color coded 

to the season (Orange for summer, blue for winter). 

• Flicker, based upon the mode selected in the setup dialog. 

To change the settings at any time, you can click the Change Settings button to 

display the Detailed Results Setup dialog. 

Printed Output 

Results Summary Report 

A summary of SEDS results can be previewed on-screen or sent to a selected printer. 

Figure 5-7 shows an example SEDS report. To view the printed report, click File Print 

Report. 

 

Figure 5-7 Example SEDS printed summary report 
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Printing Graphic Screens 

Clicking on the File  Print Design menu item can print the secondary circuit image, 

with the result showing on that tab. 

Copying Circuit Configuration to Other Documents 

The secondary circuit configuration can be copied to other documents by two different 

methods. By clicking File  Save Graphics, the circuit configuration is saved as an 

enhanced metafile. This file can then be inserted into another document, such as a 

report. The other approach is to click Edit  Copy to Clipboard. Then, switch to the 

other application, such as a word processor, and paste the image into the document. 

Neither method includes calculation results, other than cable current loading. 



  Advanced Single Phase Applications  

Secondary Electrical Design Software Application Guide   

Restricted Distribution – See Legal Notice  6–50 

Section 6 Advanced Single Phase Applications  
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Since its creation in 1997, SEDS has had significant new functionality built on top of the 

base calculation engine. This section is dedicated to providing users information on 

how to use the advanced features of SEDS. Although these features may not be used 

as often as the standard SEDS functionality, they have the potential to improve 

efficiency and lower overall design costs. 

Optimization 

The intent of this guide is to help users of older versions of SEDS understand the new 

optimization capability. This new version is very powerful because it enables designers 

to develop secondary systems that have the lowest cost for available equipment. 

There is the potential that SEDS optimization will help utilities save significant costs 

related to secondary system layout. 

SEDS Single-Phase Optimization will select the lowest cost combination of cables and 

transformers from a specified list to satisfy the voltage drop, flicker, and cold load 

pickup constraints. The user interface for SEDS has remained largely the same with the 

addition of a Detailed Results tab and an Optimization button in the lower right corner 

of the main window. In fact, the basic SEDS program remains the same and can be 

operated without running the optimization engine. In addition to the optimization 

capability, the latest version of SEDS has several new user interface features. 

Algorithm Overview 

The SEDS design optimization feature is based upon a custom multi-pass algorithm 

that “crawls” from the loads back to the transformer and removes the voltage drop, 

flicker, transformer loading, cable ampacity, and short circuit violations while it 

traverses the topology. The algorithm methodically increases or decreases the 

conductor and transformer sizes to remove violations and minimize first cost plus cost 

of losses. If there are no technical violations, the algorithm will work to minimize the 

total system cost. This feature is useful to determine if there are alternative lower cost 

designs that could satisfy the technical requirements. It has been discovered that very 

few utilities effectively minimize secondary system costs while attempting to meet the 

technical design requirements, such as voltage drop.  Often secondary systems were 

designed with significant margin between the technical requirement and the actual 

designed value. The algorithm tests various configurations within a set of user-

definable constraints to find a lower cost option.  The cost equation that is minimized is 

shown in Equation 1. 
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Equation 1: Total Cost Equation 

Where 

Ct = Total owning cost of system 

Ctrans = Transformer first cost ($) 

Ccable = Cable(s) first cost ($) 

Cnode = Node(s) or pedestal(s) first cost ($) 

Atrans = Transformer A factor ($/watt) 

Btrans = Transformer B factor ($/watt) 

LossNL = Transformer no load losses (watts) 

LossLL = Transformer load losses (watts) 

Bcable = Cable B factor ($/watt) 

Icable = Worst case conductor current (amps) - Calculated 

Rcable = Worst case cable resistance (ohms) 

KVARating = The transformer kVA rating (kVA) 

KVALoading = The worst case transformer kVA loading (kVA) - calculated 

Equation 1 includes the A and B factors used to cost evaluate transformer losses.  

These factors are commonly used by planning engineers to cost-evaluate distribution 

transformers during the procurement process.  The remaining data is either calculated 

or required input data. 

Optimization Data 

The optimization is based upon total owning cost including or without the cost of 

losses. This means that additional data is necessary for transformers, cables, and 

nodes. To view the additional data requirements, go to Edit Custom Parameters and 

view the data forms for each component. If you have an older SEDS database, then 

you will need to contact your DSTAR representative to have it updated. If you intend to 

use the optimization functionality, then you will also need to provide costs associated 

with transformers, nodes, and cables. 

For transformers, the additional data items associated with optimization are cost, load 

loss, and no load losses. These are shown in Figure 6-1. For cables/conductors, cost 

per foot and “cable in stock” are new items. The “cable in stock” checkbox should be 
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selected for all cables/conductors that you would like to be used during the 

optimization. This feature enables users to perform calculations on old out of stock 

cable/conductors, but prevents them from being selected during the optimization 

process. These are also shown in Figure 6-1. 

  

Figure 6-1 Transformer and Cable Custom Data 

Under Edit Custom Parameters, there is a new menu item, Economic Parameters (see 

Figure 6-2). The user specifies the A and B factors for transformers and cables and also 

the cost per node via this window. With all of this new data entered, the user is ready 

to start using optimization. It should be noted that the optimization routine needs costs 

to perform. If you choose not to enter costs, then SEDS can be run using traditional 

methods. 
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Figure 6-2 Economic Parameter Data 

After entering a secondary system layout in the Design tab, the user may click on the 

Detailed Results tab to view the voltage drop, flicker, and item description in one 

single view. An example of Detailed Results is shown in Figure 6-3. In this example, all 

three loads show both voltage drop and flicker violations. Violations are indicated by 

color and also will blink (animation) on the screen. Flicker violations are shown as red 

and voltage drop violations are shown as orange or blue depending on if the violation 

occurs in the winter (blue) or summer (orange). Figure 6-4 shows the Detailed Results 

Setup window that may be accessed via the Change Setting button near the top 

middle of the main screen. The Detailed Results Setup window allows the user to define 

which result is displayed when viewing the detailed results. In previous version of SEDS, 

the user needed to click a button to view the summer and winter voltage drop results. 

Now, via the detailed results, SEDS will determine the worst-case voltage drop and 

automatically display that result. 



  Advanced Single Phase Applications  

Secondary Electrical Design Software Application Guide   

Restricted Distribution – See Legal Notice  6–55 

 

Figure 6-3 Detailed Results 

 

Figure 6-4 Detailed Results Setup Selections 

After entering a design, the user may click on the Optimization button in the lower 

right-hand corner. This will display the window shown in Figure 6-5. The version 0 

design shown is the calculated total cost for the system that appears in the Design tab. 

To see the details of the version 0 design, simply double-click on the row. The 

transformer, node, and cable cost details are shown in Figure 6-6. It should be noted 
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that this particular design shows 3 violations (at each node) that need to be cleared via 

the optimization process. The optimization algorithm will step through cable and 

transformers to determine the most economical mix that clears the violations. 

 

Figure 6-5 Design Optimization Results 

 

Figure 6-6 Design Details Window 

Before clicking the Optimize button, the user should click the Constraints button to 

confirm the constraints that will frame the optimization engine. It is important that 

reasonable constraints are entered to limit the search space and improve the 

performance of the optimization engine. Figure 6-7 shows the transformer and cable 

constraints placed on the optimization process. If these constraints are changed, it is 

necessary to click the Save As Defaults button to save the changes. 
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Figure 6-7 Optimization Constraints Window 

After confirmation that the constraints are reasonable, click the Run button shown in 

Figure 6-7 or the Optimize button shown in Figure 6-6. Either of these buttons will 

initiate the optimization engine. A completed design optimization result is shown in 

Figure 6-8. 

 

Figure 6-8 Completed Optimization Window 
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Each time the Optimize button is clicked, a new version appears in the Design 

Optimization window. The latest optimized design will replace the previous non-

optimized design in the Design view. The user can check to make sure all of the 

violations have been cleared by clicking the Detailed Results tab. This is shown in 

Figure 6-9. 

 

Figure 6-9 Optimized Results with Violations Cleared 

Since the new optimization engine relies on equipment costs to perform the 

optimization, transformers, nodes, and cables now have an associated cost that must 

be entered into the SEDS database. In addition, each transformer now has a summer 

and winter cold load pickup criteria. A review of the SEDS database is recommended to 

determine which data need to be added. 
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Section 7 Inputting Three Phase Data 
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This section of the SEDS Application Guide provides step-by-step instructions for 

inputting data for an example Three Phase system. SEDS is a very easy to use program, 

and following through this example will provide you with sufficient familiarity to set up 

and run your own cases. 

SEDS: Three Phase is limited to radial, three-phase secondary distribution systems. 

SEDS can accommodate up to one hundred loads and up to twenty-five tiers. Figure 

1-5 illustrated the definition of a load tier. 

Opening the Program 

SEDS Three Phase opens to the Design Tab window shown below in Figure 7.1. The 

Design Tab is a drawing tablet where all the system components are graphically added 

and their parameters (properties) are set. The other tabs (Voltage Drop, Flicker, and 

Short-Circuit) are selected to reveal calculation results, after the circuit design has 

been entered. 

 

Figure 7-1 SEDS Three Phase Design Tab Window 

Entering the Circuit Configuration 

The first step of inputting case data in SEDS is to draw the secondary system 

configuration. On the Design Tab is the object toolbar, shown on the top right side of 

Figure 7-1, which has buttons for each circuit element plus a button for copying 

properties (parameters) of the elements. Only one of these buttons can be selected at a 

time. 
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Placing the Transformer and Primary Source Objects 

Circuit configuration input begins by placing the distribution transformer on the 

drawing tablet. Select either UG Trans, OH Trans, or OH Bank by clicking the 

appropriate button. Now, using the mouse, click on the location on the drawing tablet 

where the symbol (object) for the transformer is desired to be placed. Hold down the 

left mouse button and drag the mouse slightly, then release. Symbolic objects 

representing the transformer and its primary source will appear on the tablet as 

illustrated in Figure 7-2. 

 

Figure 7-2 Overhead transformer bank and primary source object placed on the tablet. 

The primary source and the transformer objects can be moved together to a new 

location on the tablet by clicking on the source symbolic object (three parallel lines) 

once, and then pressing the mouse button again and holding the button down while 

dragging the source and transformer to the new location. Clicking and dragging the 

transformer object in a similar manner can move the transformer object alone. 

Neither the primary source nor the transformer objects can be deleted once placed on 

the design tablet. The transformer type can be changed at any point in the design 

process by right clicking on the transformer object and then selecting the appropriate 

change in type. 

Note that the transformer object is initially red in color. This indicates that transformer 

parameters have not yet been input. Later when the parameters have been input, the 

red color disappears. 
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Inserting Nodes 

Connection points where two or more secondary cables come together (other than at 

the transformer) are called nodes. Nodes can represent a secondary panel or a pole 

where several secondary service cables connect to the secondary main. Nodes can 

also be used for transition points where the secondary cable size or type changes, or 

for transition between overhead and underground secondaries. 

The next step to laying out the secondary configuration is placing nodes (if any) on the 

tablet. In the object toolbar, select the button for Node. Now place the node object 

onto the drawing tablet by holding down the mouse button and dragging at the 

desired location. Repeat click and drag for any other nodes. Figure 7-3 illustrates two 

nodes added to the example circuit layout. 

 

Figure 7-3 Two nodes added to the circuit. 

Adding Loads 

The secondary circuit needs to have at least one load. Load objects are placed on the 

tablet by first selecting Load in the object toolbar. Click and drag on the tablet in the 

desired location for each load. Note that the secondary conductor interconnections 

between the transformer, nodes, and loads are added in the next step. The load object 

color is initially red, indicating that the parameters of the load have not yet been 

entered. Once the parameters have been entered, the object will change colors. Figure 

7-4 shows five loads added to the example circuit. 
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Figure 7-4 Example circuit with five loads placed. 

Adding Secondary Conductors 

Secondary conductors (overhead or underground) are added to the circuit in a 

different way than the transformer, nodes, and loads are placed. First, select 

Conductor from the object toolbar. Next select the beginning point (upstream end) of 

the first cable by clicking the object to which it is connected (e.g., the distribution 

transformer object). Now click the end point object of the same cable. If, after clicking 

the beginning point object, a different beginning point object is desired, select a 

different object on the toolbar and then re-select Conductor. The next object selected 

will be a conductor beginning point, instead of an end point. 

In our example, conductors have been placed connecting the transformer to the two 

secondary pedestals (nodes) and to the loads. Conductors have also been placed from 

the pedestals to two loads each. The configuration of the example is illustrated in 

Figure 7-5. Note that the conductor objects appear as broken lines, indicating that 

their parameters have not yet been specified. 
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Figure 7-5 Transformer, nodes, and loads interconnected by conductors. 

There are limitations to the placement of secondary conductors: 

• Only one conductor can have its end point on a given object. This prohibits closing 

a secondary loop, and also prohibits parallel conductors. (Secondary circuits with 

parallel conductors can be analyzed by representing the parallel cables as one 

equivalent cable, with an impedance equal to the parallel combination. 

• Only the beginning end of conductors can be connected to the distribution 

transformer object. 

• Only the downstream ends of conductors can connect to a load. You cannot 

connect a conductor from one load to another. If the actual circuit has the 

secondary conductor connecting to one load and then continuing on to another, 

then terminate the incoming cable before the first load at a fictitious node, and 

insert a very short conductor between that load and the first load. The conductor 

from the first to second load in the actual system is represented in SEDS by a 

conductor between the fictitious node and the second load. 

Order of Object Placement 

In the example shown above, the objects were placed in the order of transformer, 

nodes, loads, and conductor. It is necessary to begin with placing the transformer, and 

conductors must connect existing objects. Otherwise, the order of object placement is 

arbitrary. For example, the configuration shown in Figure 7-5 could be fully assembled 

and then a new node and load added, connected by new conductor sections. 
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Drawing Over a Graphic Image 

A useful feature of SEDS is that it allows the secondary circuit to be drawn on top of 

another graphic image, such as a floor layout showing load and transformer locations. 

Figure 7-6 illustrates this capability. 

 

Figure 7-6 Floor layout loaded as a SEDS background. 

To insert the background image, click the View  Insert Back Picture menu item, and 

select the desired image file. The background image must be in bitmap, Windows 

metafile, or enhanced metafile formats. The background image can also be removed 

by clicking View  Remove Back Picture. 

Specifying Object Parameters 

To enter parameters in an object, double-click on the object to open its data window. It 

is also possible to copy properties from one object to another similar object (e.g., from 

a load to a load or a conductor to a conductor). This will be described later. Note that 

nodes do not have any properties to specify. 

Parameters in SEDS are set by selecting from a pre-existing list, or by directly inputting 

parameters. Your company’s SEDS Program Administrator, based on materials and 

practices used by your company, set up the pre-existing lists in SEDS. These lists are 

maintained in a separate password-protected area of SEDS. 



  Inputting Three Phase Data 

Secondary Electrical Design Software Application Guide   

Restricted Distribution – See Legal Notice  7–66 

Source Parameters 

Optionally, the primary source voltage and/or impedance can be included in SEDS 

calculations. Source voltage will only be used in steady-state voltage drop calculations. 

Source impedance will only be used for calculating flicker and short-circuit currents. 

The SEDS default is to ignore primary-side impedance in flicker and short-circuit 

calculations, which is the same as assuming that the primary side of the distribution 

transformer is connected to an infinite bus. The default source voltage is the primary 

rating of the transformer bank, also defined as 1.0 PU. 

If it is desired to specify a primary feeder voltage and/or impedance, double click on 

the primary source object to open the properties window shown in Figure 7-7. 

 

Figure 7-7 Primary source data window. 

To enter primary source impedance, click the button marked Consider primary source 

impedance. Next, input the available short-circuit (fault) current at the transformer 

primary terminals, in Amperes. This short-circuit current should be the available 

current if the transformer primary winding were a short circuit. Thus, the appropriate 

short-circuit current for a phase-neutral (wye) connected transformer is the phase-

ground fault current, and the short-circuit current for a phase-to-phase (delta) 

connected transformer is the available phase-to-phase fault current. Enter the ratio of 

inductive reactance to resistance (X/R ratio) for the primary system. For a phase-to-

neutral connected transformer, the X/R should be that of the phase-to-neutral current 

path impedance (one-third of the sum of the positive, negative, and zero-sequence 

source impedances). Typical overhead primary systems have an X/R ratio in the range 

of 0.5 to 10, and total underground primary systems range from 0.3 to 3. 
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To enter a primary source voltage, click the button market Actual Feeder Voltage. Next, 

enter the primary line-to-line voltage applied to the transformer. This should be slightly 

more or less than the primary line-to-line voltage rating of the transformer bank. 

After entering and selecting the source object parameters, click OK. Clicking Cancel 

closes the primary source data window without executing the inputs provided. 

Transformer Parameters 

With one of the transformer buttons selected on the object toolbar, double-click on the 

transformer object to open one of the windows shown in Figure 7-8. If the object is a 

transformer bank the input window on the left will appear. If the object is an OH 

(overhead) or UG (underground) transformer then the input window on the right will 

appear. 

  

Figure 7-8 Transformer data input windows 

For OH or UG transformers, under the label marked transformer list, there is a selection 

of all padmount transformers (if the transformer object placed on the tablet is a 

padmount transformer), or all polemount transformers (if that type was placed), for 

which your company’s SEDS Program Administrator has provided data. One of these 

transformers may be selected. If so, that transformer’s parameters will show next to 

the selection list. 

The list of transformers can be filtered by using the selection boxes at the top of the 

Transformer Data window. The default filtering selection is an asterisk (*), meaning 

“wild card,” or unrestricted by that category. There are four categories of filtering: kVA 

rating, primary winding voltage, connection type, transformer type, and transformer 
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tap. Selection of a parameter in a category will limit shown transformers to those 

having the same parameter for that category. The transformer type category can be 

used for various purposes, depending how the company SEDS Program Administrator 

sets it up. It can be used to indicate special transformer features such as CSP or fusing 

options. The filtering selection for each category can be reset to the wild card value by 

clicking the appropriate Reset button. All categories can be reset using the Reset All 

button. 

If the transformer to be studied is not available on the list, then the user can optionally 

provide the transformer data directly by clicking on the check box marked User 

Specified Transformer Parameters. The transformer impedance (%Z) and resistance 

(%R) are in percent of the impedance base for the selected nameplate kVA rating. 

Resistance may not exceed the total transformer impedance. Enter the maximum 

summer and winter loading capability of the transformer, based on your company’s 

loading practices. Typically, these maximum loadings exceed the nameplate kVA. The 

tap setting selected will be used to adjust the secondary transformer voltage during 

steady state voltage calculations. 

For transformer banks there are six configurations to select from. Floating-Wye Delta, 

Open-Wye Open-Delta, Open-Delta Open-Delta, Wye Wye, Delta Wye, and Delta Delta. 

The configuration is selected by clicking on the appropriate tab at the top of the form 

shown on the left of Figure 7-8. Once the bank configuration is selected the 

parameters of the individual transformers making up the bank can be specified by 

clicking the button labeled Transformer 1, 2, or 3. The individual transformer property 

input screens are very similar to the three phase transformer input screen described 

above. The properties of transformer 1 can be copied to either of the other two 

transformers by selecting the Copy Data from T1 button. 

After all entries are complete, click OK to assign the parameters to the transformer 

object. 

Conductor Parameters 

Double-click on any conductor object to open the window shown in Figure 7-9 for 

specifying the parameters of that conductor. A selection list of conductors is shown in 

this window. This list is maintained by your company SEDS Program Administrator, and 

should contain the service cable types and sizes that your company uses. Clicking the 

Overhead or Underground buttons at the top of the window causes the conductor list 

to show only that category of conductors. 

Selection of a conductor causes the resistance and reactance per 1000’ of that 

conductor to be shown, as well as the summer and winter conductor ampacity (see 
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Figure 7-9). After selecting the desired conductor type, enter the length of the 

particular conductor section in feet and click OK. The parameters of each conductor 

object need to be set in this manner, or by using the Properties button described later. 

 

Figure 7-9 Conductor data input window. 

Load Parameters 

Double-click on any load object to open the window shown in Figure 7-10. This window 

will set the parameters for the selected load. The parameters of each load object need 

to be set using the procedure described below, or load parameters can be copied from 

one load to another using the Copy Properties function. 

A load ID box appears near the top of the load data input window. SEDS assigns a 

default name for the load, depending on which node the load is connected to. For 

example, N2L1 indicates the first load (in order of entry) connected to the second node 

(in order of entry). If the load is supplied directly from the transformer secondary 

without an intervening node, the default name will begin with S instead of N#. 

Optionally, the user can provide a descriptive name for the load, such as the house 

number or meter number. The user-supplied name is entered by overwriting the 

default name in the data input window. The load name appears on the circuit 
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configuration drawing, and in results output reports. A longer text description of each 

load can also be stored in the description field. 

 

Figure 7-10 Load data input window. 

One of the changes in SEDS V4.2 is that users can define parameters for three-phase 

loads and save them in the equipment database for retrieval. Loads can be defined as 

a combination of balanced and unbalanced phase-to-neutral (wye connected) and 

phase-to-phase (delta connected) loads. Summer and Winter KVA and PF can be 

specified. If the winter check boxes are left blank the summer values will be used for 

winter calculations. If a certain kVA category (such as Unbalanced P-P) is not being 

used the check box by the label can be left unchecked so the input fields are not 

displayed. The list box at the top of the window in Figure 7-10 allows the user to select 
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load parameters from the database to apply to a load in SEDS. Once the load 

parameters are chosen, they can be customized by the user. 

Flicker calculations require the largest transient current to be specified for each load. 

Usually, this transient current is the starting current for a relatively large motor, such 

as a pump. 

1. The first option is to click HP, RC, & PF. Motor horsepower and starting power factor 

is input and the NEMA rotor code for the motor is selected. 

2. The second option is to click Starting Amps & PF and input the motor starting 

current and starting power factor directly. This option can be particularly useful for 

a non-motor load which cause flicker, such as a welder. 

Note that the starting currents specified are used only for flicker calculations. The 

running motor load should be included in the Total Running Motor Load section. 

Transient current (i.e., motor starting current) data are not mandatory. If there is no 

transient current data provided for a load, the voltage flicker calculated will be the 

worst flicker caused by transient currents drawn by another load fed from the same 

transformer. However, if no transient loads are specified for the secondary system, the 

calculated self-induced flicker will be zero. 

The total running motor load is used to capture additional motor load that is not 

represented in the Wye Load Data or Delta Load Data sections of the form. 

At the bottom of the input form, three-phase Equipment load can be chosen from the 

database to be added. This equipment can be added via the Edit Custom Parameters 

Equipment menu item in either single phase SEDS. This enables users to setup 

customized loads that can be directly selected while building up either a single-phase 

or three-phase load. Users may click the Add Equipment button to add a new line item 

to the grid and then choose the specific equipment from the drop-down box. Likewise, 

a line item may be deleted by selecting row of interest and clicking the Delete 

Equipment button. 

After selecting or specifying load parameters, click OK to assign the parameters to the 

selected load. Repeat for all of the loads, or use the Copy Properties function described 

below. 

Copying Properties 

The Properties button can be used to copy parameters from one conductor to 

another, or from one load to another. To use this function, select Properties on the 

object toolbar. Select the object from which the parameters are to be copied from. 

Next, select the object (which must be of the same type; conductor or load) to which 

the parameters are to be copied. 
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If conductor parameters are being copied, SEDS will prompt the user for the length of 

the conductor section to which parameters are being copied. (In essence, SEDS allows 

the type of conductor to be transferred, but not the section length). 

The “copy to” process can be repeated multiple times without performing another 

“copy from.” If another object is desired to be the “copy from” object, click a different 

button on the object toolbar to reset the copy function and then click the Properties 

box. 

Deleting Objects 

Selecting the object, and then pressing Delete on the computer keyboard can delete 

load, node, and conductor objects. Be sure not to leave any “stranded” loads or nodes. 

Saving and Loading SEDS Data 

SEDS allows saving of case data, and loading of saved case data using standard 

Windows commands such as Save, Save As, and Open on the File menu. SEDS cases 

are saved with the file extension *.flw. Note that the parameters for cables, 

transformers (other than user-defined), and standard loads are contained in a separate 

SEDS database maintained by your company’s SEDS Program Administrator. An 

individual saved case contains references to this database. Any changes to 

parameters stored in the database can cause calculation results in a retrieved saved 

case to differ from the results obtained before database modification. To get reliable 

results from a saved case, the appropriate equipment database must be associated 

with SEDS when the case is loaded. SEDS will give a warning if they are not consistent. 

Use the Database Utilities button on the Main Menu to change the equipment 

database (see the Database Utilities subsection in Section 3, Launching SEDS). 
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Section 8 Obtaining Three Phase Results 
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Mouse-over Feature 

Information about each of the objects on the design pallet can be seen in the 

information box located at the bottom of the application window by moving the mouse 

pointer over the desired object. An example of the mouse-over feature when hovering 

over a cable while on the Voltage Drop tab is shown in Figure 8-1. 

 
Figure 8-1 Example of Information Box using the mouse-over feature 

After completing input of the secondary system configuration and parameters, SEDS 

performs calculations automatically when any of the output tabs (Voltage Drop, Flicker, 

or Short Circuit) are selected. Results are shown directly on the circuit diagram for each 

of these tabs. 

Voltage Drop Tab 

Clicking the Voltage Drop tab displays steady-state loading results for the system. An 

example is shown in Figure 8-2. Summer peak conditions are shown when SEDS is 

switched to the Voltage Drop tab. Winter peak conditions can be displayed by clicking 

the button marked Show Winter. Summer conditions can again be displayed by 

clicking Show Summer. Using the dropdown box below the Show Winter button can 

also change the voltage base displayed. 

 

Figure 8-2 Example voltage drop tab display 
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Secondary Conductor Currents 

The current flow is shown in the lower information boxes for each conductor for the 

selected season by using the mouse-over feature. SEDS compares the secondary 

conductor load with the conductor rating, for the chosen season. If the conductor 

current exceeds the ampacity limit, the conductor will be displayed as a thick red line 

on the diagram. 

Service Entrance Voltages 

Voltages at peak demand for the selected season are shown on the graphic circuit 

diagram. The user has the option of displaying voltage results on four different bases: a 

L-N (line-to-neutral) nominal base, a L-L (line-to-line) nominal base, and both of these 

bases in Per Unit. To change the voltage display mode, choose the appropriate base in 

the voltage selection box located to the right of the Short-Circuit tab. 

If the voltage drop at a load exceeds a warning threshold, the voltage is displayed in 

red text. The warning threshold can be set via the Edit Custom Parameters  

Warning Criteria menu. 

Flicker Tab 

Switching to the Flicker tab will display voltage change caused by the transient loads, 

such as motor starting. An example is shown in Figure 8.3.  

 

Figure 8-3 Example flicker calculation results. 

Note that the total transient voltage regulation is the sum of the transient voltage 

change (flicker) and any steady-state voltage drop present at that time. Customer 
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irritation from transient load changes is a function of the relative change in light 

output, and not the minimum absolute voltage during the event. Thus, the Flicker tab 

displays only the transient voltage change. 

When SEDS is switched to the Flicker tab, the display shows percent voltage change at 

service entrances due to transient loads at that service only. This is termed self-

induced flicker. The effects of a transient load at one service on flicker voltages at 

another can also be displayed by clicking the button on the upper right of the window 

marked Show Mutual. There are two options for the mutual flicker display. The option 

marked Include Self (the default option), displays shows the worst-case flicker from 

loads anywhere on the system, including flicker caused by loads at the same service. 

The second option, Exclude Self, shows only the greatest mutual flicker at each service 

as a result of transient loads at another service. The Exclude Self option allows both 

types of flicker to be viewed. All of the mutual flicker output includes an indication of 

the load responsible for the worst-case flicker that is shown. 

If any load is subject to a voltage flicker magnitude greater than a specified threshold, 

the flicker magnitude is displayed in red text. The warning threshold can be set via the 

Edit Custom Parameters  Warning Criteria menu. 

Short Circuit Tab 

Switching to the Short Circuit tab will cause SEDS to calculate and display the available 

short-circuit currents at each load and the transformer secondary terminals. Figure 

8-4 shows an example. 

 

Figure 8-4 Example short circuit calculation results. 
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Any short-circuit current greater than a specified threshold is displayed in red text. The 

warning threshold can be set via Edit Custom Parameters  Warning Criteria. 

Printed Output 

Results Summary Report 

A summary of SEDS results can be previewed on-screen or sent to a selected printer. 

Figure 8-5 shows an example SEDS report. Click on  File  Print Preview. 

 

Figure 8-5 Example SEDS printed summary report. 

Printing and Copying Circuit Image 

Clicking on the File  Print Screen menu item can print the secondary circuit image, 

with the result showing on that tab. The secondary circuit configuration can be copied 

to other documents by two different methods. By clicking File  Save Graphics, the 

circuit configuration is saved as an enhanced metafile. This file can then be inserted 

into another document, such as a report. The other approach is to click Edit  Copy to 

Clipboard. Then, switch to the other application, such as a word processor, and paste 

the image into the document. 
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Section 9 SEDS Single Phase Calculations 
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Coincidence Factors 

All transformer loading, cable current, and steady-state voltage drop calculations in 

SEDS are based on coincident peak loading. The usual utility practice is to apply 

coincidence factors to the sum of individual loads to estimate the coincident load. The 

coincidence factor decreases as the total number of loads increases. Also, utilities 

often use different coincidence factors for different load classifications, such as homes 

with electric heat versus homes with non-electric heat. 

Conventional Coincidence Factor 

Where loads of unequal size or type are combined, however, the conventional 

coincidence factor method can give unreasonable results. 

The coincidence factor for n loads, Kn, is conventionally defined as: 

~ ~
( )S K STotal n n m

m

n





1  

This type of coincidence factor does not always give reasonable answers if the loads 

are different in size or nature. Consider the following example: 

A distribution transformer serves one large, all-electric residence of 12 kVA peak 

load and a small residence without electric heat or A/C with a peak load of 5 

kVA. If the coincidence factor for two loads (K2) is 0.7, the conventional 

approach would say that the peak coincident load is 11.9 kVA. This is less than 

the large house’s load. The coincident peak, however, should never be less than 

the largest load. Thus, the conventional method fails in this situation. 

Coincident Incremental Contribution 

A new technique has been developed and implemented in SEDS, which provides more 

reasonable estimates of coincident peak demand in the case where unequal size or 

dissimilar type loads are on the same secondary system. To allow for loads of mixed 

size or mixed type, a coincident incremental contribution (CIC) factor k for each load 

will be used to determine the net coincidence factor K’n for n loads. The net 

coincidence factor K’n is determined as follows: 

1. First, rank all loads supplied in order of largest to smallest nominal kVA. (S1, S2, 

… Sn). Scalar values of load are used ( S S P Qn n n n  
~ 2 2

) 

2. Next, calculate the net coincidence factor: 
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Where  k2, k3, etc. are the CIC factors for the second, third, etc. loads in order of size. 

 

When loads are of mixed type, the CIC factor for the respective load type and load-size 

order are used for each kn. 

The method shown above is equivalent to the conventional method if all loads are 

equal in size and the same coincidence factors apply to all loads. Otherwise, the 

method provides a weighted average. 

Determining Coincident Incremental Contribution Factors 

The CIC factors can be easily determined from the conventional coincidence factors. 

The CIC factor for the nth largest load (kn) is: 

)1(1   nKKnk nnn  

Example Calculation: Mixed Load 

A utility uses the following coincidence factors (conventional definition) for general 

residential and all-electric residential loads: 

Number of Loads 1 2 3 4 

All Electric Residential  1.00 0.90 0.84 0.80 

General Residential 1.00 0.65 0.53 0.47 

Coincident peak loading is to be estimated for the following four loads to be served 

from the same distribution transformer: 

#1. 14kVA peak, 0.85 pf all-electric residence 

#2. 10 kVA peak, 0.85 pf all-electric residence 

#3. 7 kVA peak, 0.95 pf residence (general class) 

#4. 5 kVA peak, 0.95 pf residence (general class) 
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First, the CIC factors need to be determined from the given coincidence factors: 

Size Order of Load k2 k3 k4 

All Electric Residential  0.80 0.72 0.68 

General Residential 0.30 0.29 0.29 

The net coincidence factor is: 

708.0
571014

529.0729.0108.014
' 




nK

 

Because the power factors of the loads are not the same, the total coincident kVA 

loading must be based on adding loads as phasors. The total coincident load is: 

        

kVASS

kVARjkWS

jjS

peakcoincidentpeakcoincident

peakcoincident

peakcoincident

3.25
~

6.115.22
~

95.0195.05785.0185.01014708.0
~

__

_

22

_







 

Coincident Current Calculations 

All load currents in SEDS are the coincident peak currents for that branch (cable or 

transformer). SEDS determines the current for each branch using the CIC method 

based on the loads downstream of that branch. 

Individual load currents are calculated using the following: 

~
I

P j
pf

pf

n

n



  












1

1

240

2

 (P in Watts) 

Note that these calculations assume the current to be invariant with voltage (i.e., 

constant-current loads). This is a common distribution engineering approximation, and 

is the approximate net composite characteristic of combined constant impedance 

(e.g., incandescent lighting) and constant power (thermostatically-controlled loads) in a 

home. 
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Voltage Drop Calculation Assumptions 

SEDS steady-state voltage drop calculations assume that the primary voltage is fixed 

at the nominal primary winding voltage rating. Thus, the no-load voltage at the 

secondary of the transformer is assumed to be the nominal 120/240 Volt value. 

Primary voltages at a given feeder location depend on many factors other than the 

loading of the secondary system under study. Primary voltages are affected by load 

tap changing substation transformers, voltage regulators, and feeder capacitor banks. 

Primary system modeling, however, is beyond the scope of SEDS. Primary voltage 

behavior, however, does not significantly affect the relative voltage regulation. For 

example, if SEDS calculates 117 Volts at a load (assuming a 120 V source), the voltage 

drop is three volts. If the effective source voltage (no-load transformer voltage for the 

given primary voltage condition) is 118 Volts, then the actual service voltage will be 

three volts less or 115 Volts. 

Voltage drop calculations along the secondary system use the coincident peak current 

for each section. Because the currents into a node serving more than one load does 

not necessarily equal the sum of the currents out, the circuit analysis does not strictly 

obey Thevenin’s laws. In essence, SEDS voltage calculations are an approximation 

worst-case voltage drop at each load service, but do not provide the simultaneous 

voltage profile over the whole system at any given instant in time. 

Because constant current loads are assumed, voltage drop calculations need to be 

iterative only to account for the relatively small phase shift in voltage over the system. 

The iterative technique used in SEDS is very robust, and should converge without 

notice by the user for any reasonable distribution system case. 
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Flicker Calculations 

Flicker calculations assume that the transient load is a constant impedance defined by: 

 
~

kerZ
I pf j pf

flic

start start start


   

240

1 2

 

 

Figure 9-1 Example system, used for defining flicker calculations. 

Voltage flicker is calculated using simple impedance division. Figure 9.1 shows a simple 

secondary system. Self-flicker at load N1L1, due to a transient load at the same service 

having an impedance Zflicker(N1L1), is calculated by the following: 

V
Z

Z Z Z Z Z
self N L

flic N L

flic N L m xfmr source

( )

ker( )

ker( )

~

~ ~ ~ ~ ~1 1

1 1

1 1 1

1 100% 
   













 

 

If the user selects the Infinite Bus option for the primary source impedance, Zsource  is 

zero by definition. Otherwise, the primary feeder impedance, reflected to the 

secondary side (Zsource ) is defined as: 

     ~
cos sin(Z

I V
Tan X

R j Tan X
Rsource

sc pri


 

   
240

10

2

6

1 1

 where (X/R) is 

the ratio of reactive impedance to resistance of the primary short-circuit path, 

Isc is the primary current in kA, available if the transformer primary terminals 

are shorted together, and Vpri is the primary winding voltage rating in kV. 

Self flicker at load N1L2, due to a transient load at the same service having an 

impedance Zflicker(N1L2), is calculated similarly: 

N1L1

N1L2

   

 

Zsource

Zxfmr

Zm
Z1

Z2
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The mutual flicker at load N1L1 is: 

V
Z Z

Z Z Z Z Z
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The mutual flicker at load N1L2 is: 

V
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If there are more than two loads, the mutual flicker at any given load is the most 

severe of the flicker caused by the other loads. 

The flicker at the transformer secondary is: 
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Short-Circuit Current Calculations 

Available short-circuit currents at the load service entrances and at the transformer 

secondary terminals are calculated by SEDS. The fault path is assumed to be from 

ungrounded leg to ungrounded leg (i.e., across the 240V). The system is represented as 

an ideal nominal (240 V) voltage source behind the primary source impedance, as 

reflected through the transformer turns ratio. If the user selects the Infinite Bus option 

for the primary source impedance, the reflected primary source impedance (Zsource) is 

zero. Otherwise, the impedance is as determined from the user-input primary winding 

voltage, short-circuit current available, and primary system (X/R) ratio by the same 

calculation as used for flicker calculations. 

For the load service N1L1 in Figure 9-1, the available short-circuit current is: 

I
Z Z Z Z

sc

source xfmr m


  

240

1

~ ~ ~ ~
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Section 10 Program Administrator Information 
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Custom Parameters 

A very useful feature of SEDS is that the user can select transformers, cables, and loads 

by name or description from lists. These lists can be customized to conform to the 

materials and practices of the utility using the program. Maintenance of the custom 

parameters is assumed to be performed by a Program Administrator, who has access 

to the more detailed information needed to create the standardized models. 

Custom parameters are added, modified, and deleted using the Edit Custom 

Parameters menu item in SEDS. To avoid inadvertent changes to the custom 

parameters, access to this menu is protected by a password. The password, at 

program installation, is “power.” Once this password is entered, the Administrator can 

change the password. 

Database Security 

The Database Security menu option is used to unlock the current database and access 

the user input forms for both single phase and three phase data. To get to this option, 

select Edit Custom Parameters  Enter Password. When the database is locked, the 

data editing items are disabled in the menu as shown on the left side of Figure 10-1. 

The password window in on the right side of Figure 10-1 will appear when the menu 

item is selected. The default password, at program installation, is “power.” Once this 

password is entered, the Administrator can change the password. 

     

Figure 10-1 Locked database utilities menu and password window for database access 

When the correct password is provided, the database will be unlocked and data 

editing menu items will be enabled on the  Database Utilities menu bar as shown in 

Figure 10-2. 
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Figure 10-2 Unlocked database utilities after entering correct password 

Custom parameters can now be added, modified, and deleted using the user input 

forms available under Edit Custom Parameters. A detailed description of this data as 

well as the user forms can be seen in the Section 10 Program Administration 

Information. 

SEDS Data Structure 

All of the customized selection list data used in SEDS, such as standard transformers, 

conductors, and loads, are stored in an Access database file, which is originally loaded 

into the same file folder as the program executable (secondary.exe). The database 

name is SEDS_database.mdb. Note that all changes made to the custom parameters 

using the Edit Custom Parameters menu are immediate and irreversible as soon as 

Update or Close is clicked on the data forms accessed by Edit Custom Parameters. No 

explicit “save” is necessary to execute the changes. Care should be exercised in 

making changes to the custom data in the database, and this master database file 

should periodically be backed up. 

The program installs with a database having only one or a few example entries in each 

category. The Administrator should build the database with data specific to their 

company. The updated SEDS_database.mdb should be distributed to end users, who 

should replace the stripped-down version placed into the folder where SEDS is installed 

by the installation routine, with the customized version. Note that the database file can 

reside anywhere on the hard drive and can be pointed to SEDS using the Database 

Utilities function found on the main menu. 

Do not delete all data from a given category. The user should first install their 

customized data, and then delete the examples if desired. If another data entry 

references the example to be deleted, then the record cannot be deleted unless the 

link is changed. For example, an example load may reference the example coincidence 
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class. The example coincidence class record cannot be deleted without first changing 

the coincidence class reference in the example load record to a coincidence record 

which is to be retained. Alternatively, the example load can be deleted first, then the 

example coincidence class. 

Deleting data from the database may cause problems when recalculating results using 

previously saved SEDS case files. Subsequent runs of that case will cause SEDS to 

replace the deleted item with the next item in the database. This next item may not be 

a suitable replacement (e.g., a 100 kVA transformer might be replaced with a 10 kVA 

transformer if the former is deleted from the database). Therefore, any SEDS runs 

referencing custom data items that have been deleted should have an appropriate 

replacement item selected by the user. 

Modification to the parameters of a custom data item will change calculation results of 

any saved files that reference the changed data item. 

Initial Data Setup 

Note that all custom data present in SEDS on program installation are for illustration 

only. This data should not be assumed to be correct, or to even be representative of 

typical parameters. 

A company’s SEDS program administrator should delete all data from the custom 

parameters, and enter data relevant to their material and design practices. The only 

exception is the motor type called “no motor” which should be retained for associating 

with loads for which there is no assumed transient load. The modified copy of 

SEDS_database.mdb should be provided to users installing SEDS. 

Maintaining Custom Data 

Transformer Data 

After entering the password, custom transformer data can be accessed via the Edit 

Custom Parameters  Transformer menu item. The administrator is given the choice 

of the following: 

Data This item is the basic list of transformers and their parameters. 

Some of the parameters, such as size (kVA rating), type, and 

primary winding voltage are selected from lists rather than typed 

in. 

Size This item is the list of standard transformer sizes. All transformers 

listed in the Data list must have a kVA rating selected from this 
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Size list. If a size is deleted from the size table, then all 

transformers associated with that size would be eliminated from 

the transformer Data list. 

Type This item is the list of transformer “types.” It can be used flexibly, 

depending on a company’s needs. All transformers must 

reference a type on this list. For example, a company may stock 

padmount transformers with and without bayonet fusing. Type 

can then be used as a field to allow the user to filter transformers 

“with bayonet” and “without bayonet.” If there are transformers 

with no special attributes, a type entry such as “none” should be 

created. If a Type is deleted from the Type table, then all 

transformers associated with that Type will be eliminated from 

the transformer Data list. 

Primary Voltage This item is the list of primary winding voltages (line-to-ground 

voltage for transformers connected phase-to-neutral, and line-

to-line voltage for transformers connected phase-to-phase). All 

transformers in the Data list must have a primary winding 

voltage selected from this list. If a voltage is deleted from the list, 

then all transformers associated with that voltage will also be 

deleted. 

Secondary Voltage Only used in Three Phase SEDS - This item is the list of secondary 

winding voltages (line-to-ground voltage for transformers 

connected phase-to-neutral, and line-to-line voltage for 

transformers connected phase-to-phase). All transformers in the 

Data list must have a secondary winding voltage selected from 

this list. If a voltage is deleted from the list, then all transformers 

associated with that voltage will also be deleted. 

Conductor Data 

The list of standard conductor types, and their parameters, can be accessed via the 

Edit Custom Parameters  Cable menu item. Resistance and inductive reactance are 

entered in units of ohms per 1000’. Note that conductor impedances are specified on a 

circuit basis, that is the impedance down one leg and back the other. This is twice the 

per-conductor impedance. Summer and winter ratings are in Amperes. 
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Custom Load Data (Single Phase SEDS Only) 

The list of standard load types, and their parameters, can be accessed via the Edit 

Custom Parameters  Load menu item in Single Phase SEDS. The fields for 

Coincidence Class and Motor Load must be selected from the lists provided. 

Coincidence Class indicates the table of coincidence factors associated with the load 

type. 

To modify the tables of coincidence factors, select the Edit Custom Parameters → 

Coincidence menu item. A window such as shown in Figure 10-3 is displayed. For each 

coincidence class, enter the conventional coincidence factors to be used for 2 to 25 

loads. The coincidence factors to be entered here are simply the ratio of the coincident 

peak load for a transformer or cable serving n identical loads, divided by n times the 

peak demand of one load. The coincidence factors should never increase as the 

number of loads increase. All calculations of the coincident incremental contribution 

(CIC) method are performed internal to Single Phase SEDS. 

Note that, if a coincidence class is deleted, all load types referencing that coincidence 

class will also be deleted. 

All defined single phase loads must reference a motor load, representing the transient 

load associated with that load type. To modify the tables of motor types, select the Edit 

Custom Parameters  Motor menu item in Single Phase SEDS. A window such as 

shown in Figure 10-4 is displayed. There are two options for data input: 

1. The motor starting current can be defined directly by the Amperes and starting 

power factor. 

2. Motor horsepower can be specified along with the NEMA locked-rotor current code. 

These codes are listed in Table 10.1. The power factor of the starting current must 

also be specified. SEDS calculates the starting current based on the following 

formula: 

        
                       

            

√ 

 

The SEDS database delivered with the program has a motor type called “No Motor.” 

This type should not be deleted, as it cannot be recreated. 
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Table 10.1 Locker Rotor Current Codes 

Code  kVA/hp* 

A 0.00 - 3.14 

B 3.15 - 3.54 

C 3.55 - 3.99 

D 4.00 - 4.49 

E 4.50 - 4.99 

F 5.00 - 5.59 

G 5.60 - 6.29 

H 6.30 - 7.09 

J 7.10 - 7.99 

K 8.00 - 8.99 

L 9.00 - 9.99 

M 10.0 - 11.19 

N 11.2 - 12.49 

P 12.5 - 13.99 

R 14.0 - 15.99 

S 16.0 - 17.99 

T 18.0 - 19.99 

U 20.0 - 23.39 

V 22.4 and up 

* SEDS uses the upper limit of each range 

 

Figure 10-3 Coincidence data window. 
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Figure 10-4 Motor Data Window 

Custom Images and Equipment 

The administrator can customize the images used for each component represented in 

SEDS. This enables administrators to use images that may be consistent with your 

utility practices. To access the image customization window, the user must select Main 

Menu and click on Database Utilities. After opening the Database Utilities window, click 

on the Database Security  Unlock Database menu item and enter the Program 

Administrator password. The menu item list will be expanded as shown below in Figure 

10-5. 

 

Figure 10-5 Database Utilities Menu 

To customize the Images, simply click the Images  Customize Images menu item. 

Figure 10-6 shows the Custom Image window. To assign your own custom image, click 

on the desired image to change and choose a *.bmp file. Typical image pixel sizes are 

in the range of 60 pixels x 30 pixels. Users will need to experiment with image sizes to 

make layouts look reasonable. The default images are located in the SEDS installation 

directory and have filenames consistent with the image type. 
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Figure 10-6 Customize Image Window 

To customize the Equipment, simply click the Equipment  Edit Equipment menu 

item. Figure 10-7 shows the Equipment edit window. From this window, users can 

create custom single-phase and three-phase loads. These loads will then be exposed 

to users who choose to build up a load based upon equipment. 
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Figure 10-7 Equipment Edit Window 
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Section 11 SEDS Command Reference 
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Drop Down Menu Bar 

SEDS has a standard Windows menu bar, shown in Figure 11-1 that can be used to 

access various program commands and functions. Table 11.1 shows all of the menu 

items and their associated functions. 

 

Figure 11-1 Instructions for Opening An Existing Input Data File 

1. From the main window select the Open menu item under File. 

2. A window will be displayed for selecting the folder/directory and filename of the 

data file. The default file type is .flw for all SEDS input files. 

3. Select the desired filename, click OK, and SEDS will load the input file. All of the 

inputs should change to reflect the new input file. Also, the top of the main window 

should display the complete filename and path of the currently opened file. 

Instructions for Saving Data and Using the Save As Function  

At any time during the data input process, the input data can be saved. Saving the 

input data can be accomplished in a number of ways: 

1. Select Save from the main menu. This is under the File menu item. If this is the first 

save then a standard looking save window will appear. Enter the descriptive 

filename in the folder/directory of choice and click OK. If the data has already been 

saved to a file, then clicking the Save icon will overwrite the old data with the new 

data. No save window will appear. 

2. If the input data has already been saved, and it is desired to save the data to 

another filename, then the Save As menu item under File should be selected. This 

will display the same window that was described above in 1. 

In all cases, the suggested file extension for the input data files is .flw (default 

extension). This will assist the users in identifying the data files associated with SEDS. 

Command Reference 
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Table 11.1 Menu Items and Functions 

Menu Item Name Function 

File  

New Erases existing data and opens a new SEDS case. 

Open Select and open an existing input data file. 

Save Save the current data file. 

Save As Save the current data file under a different filename 

Save Graphics (*.EMF) Saves the circuit image to an enhanced metafile (.emf) file 

Balanced Calculations Switches SEDS into Balanced Calculation Mode 

Unbalanced 
Calculations 

Switches SEDS into Unbalanced Calculation Mode 

Print Report Displays a preview of the summary report showing all 
results of analysis. This report can then be sent to a printer 
for a hard copy.  

Print Design Prints current screen  

Main Menu Returns SEDS to the main menu where  

Exit Exits SEDS 

Edit  

Properties Edits the properties of the selected object. This can also be 
accomplished by double clicking on the object 

Copy to Clipboard Copies the circuit image to the Windows clipboard 

View  

Scrollbars Turns on the tablet scrollbars, effectively allowing the user 
to draw larger designs 

Grid Places a grid in the background of the window. Objects can 
be snapped to the grid 

Zoom Zooms window by 75%, 100%, and 150% of Normal 
window 

Insert Back Picture Inserts a graphic image in the background of the window. 
The image must be a bitmap (*.bmp), Windows metafile 
(*.wmf), or enhanced metafile (*.emf). 

Remove Back Picture Removes the graphic image from the background of the 
window 

Edit Custom 
Parameters 

 

Warning Criteria Displays the warning criteria window to allow adjustments 
of warning criteria for out-of-limits voltage regulation, 
flicker, or short-circuit current. 

Node and Load Prefixes Allows the user to edit the templates that are used by 
default to name the nodes and loads as they are placed 

Password Displays the password window for input of password to 
obtain access to the SEDS database (for use by the SEDS 
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Menu Item Name Function 

Program Administrator). 

Transformer  Displays transformer data window to allow adjustments of 
transformer data 

Load ** Displays load data window to allow adjustments of load 
data 

Cable Displays cable data window to allow adjustments of cable 
data 

Motor ** Displays motor data window to allow adjustments of 
motor data 

Coincidence ** Displays coincidence factor data window to allow 
adjustments of coincidence factors. 

Help  

Help Contents Displays a help box for SEDS 

About Displays the program information window 

** Available in Single Phase SEDS Only 

Tabs 

Tabs provide access to the data input (Design) and results (Voltage Drop, Flicker, Short-

Circuit, and Detailed Results) screens. Figure 11-2 shows the tabs that appear just 

below the SEDS menu bar. 

 

Figure 11-2 Mode Tabs. 

Design Tab 

The Design Tab is where all the system components are graphically added and their 

properties are set. It consists of a drawing tablet and an object toolbar shown below in 

Figure 11-3. Selecting a graphic circuit element button on the object toolbar and then 

dragging the mouse around the place desired on the drawing tablet will create that 

object in that place on the board. The process for adding each object is described in 

Table 11.2. 

 

Figure 11-3 Object Toolbar for Single Phase 
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Table 11.2 Processes for adding objects 

Process Process Details 

Adding a transformer Only one transformer can be added to the design layout. To 
add a transformer you must first select either transformer 
type button on the object toolbar. Next click and drag on the 
location you want to place the transformer. When you 
release the mouse button the transformer is added.  

Adding a node To add a node to the design layout first select the node 
button on the object toolbar. Next click and drag on the 
location you want to place the node. When you release the 
mouse button the node is added. 

Adding a load To add a load to the design layout first select the load 
button on the object toolbar. Next click and drag on the 
location you want to place the load. When you release the 
Mouse button the load is added. 

Adding a cable To add a cable to the design layout first select the cable 
button on the right side of the screen. Next select the origin 
of the cable followed by the destination of the cable. The 
text box, at the top of the screen, will prompt you for the 
selections.  

Adding a primary 
source 

The primary source is automatically created when a 
transformer is created. Primary source impedance is used 
for flicker and short-circuit calculations, but not steady-
state voltage drop calculations. The default value for the 
primary source impedance is zero (an infinite bus) 

Setting Properties Once an item has been created on the design layout 
double-clicking on that item can set its properties. This will 
bring up a menu box that will allow you to edit or set the 
item's properties.  

Copying Properties Properties of one item can be copied to another item by 
selecting the copy properties button on the object toolbar. 
The text box at the top of the screen then prompts you to 
select the item to be copied. Then you are prompted for the 
item to copy properties to.  

Adding a Custom 
Comment 

To add a custom comment, or freeform text, to the design 
layout, select the Caption button from. Click and drag to 
draw a box in the approximate area where you want the 
caption. When you let go of the mouse, a dialog will appear 
for entering the caption. The font and background color can 
be selected from this dialog. 

Size Transformer 
Button ** 

By clicking the Size Transformer Button the program will 
evaluate the loading on the transformer and suggest a 
different size if the existing transformer is under or over 
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Process Process Details 

loaded. Transformer loading limits are set in the Edit Custom 
Parameters, Transformer, and Data. 

Design Menu Button ** When the Size Transformer button is selected it toggles to 
Design Menu. This allows the user to edit the secondary 
design.  

Deleting a Component To delete a component, select the node (left click) and hit 
the keyboard delete key. When a node is deleted it will also 
delete any associated cable links. Do not leave any stranded 
loads. Execution of calculations with stranded loads may 
cause a program crash. 

Adding a transformer Only one transformer can be added to the design layout. To 
add a transformer you must first select either transformer 
type button on the object toolbar. Next click and drag on the 
location you want to place the transformer. When you 
release the mouse button the transformer is added.  

Adding a node To add a node to the design layout first select the node 
button on the object toolbar. Next click and drag on the 
location you want to place the node. When you release the 
mouse button the node is added. 

Adding a load To add a load to the design layout first select the load 
button on the object toolbar. Next click and drag on the 
location you want to place the load. When you release the 
Mouse button the load is added. 

Adding a cable To add a cable to the design layout first select the cable 
button on the right side of the screen. Next select the origin 
of the cable followed by the destination of the cable. The 
text box, at the top of the screen, will prompt you for the 
selections.  

Adding a primary 
source 

The primary source is automatically created when a 
transformer is created. Primary source impedance is used 
for flicker and short-circuit calculations, but not steady-
state voltage drop calculations. The default value for the 
primary source impedance is zero (an infinite bus) 

Setting Properties Once an item has been created on the design layout 
double-clicking on that item can set its properties. This will 
bring up a menu box that will allow you to edit or set the 
item's properties.  

Copying Properties Properties of one item can be copied to another item by 
selecting the copy properties button on the object toolbar. 
The text box at the top of the screen then prompts you to 
select the item to be copied. Then you are prompted for the 
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Process Process Details 
item to copy properties to.  

Adding a Custom 
Comment 

To add a custom comment, or freeform text, to the design 
layout, select the Caption button from. Click and drag to 
draw a box in the approximate area where you want the 
caption. When you let go of the mouse, a dialog will appear 
for entering the caption. The font and background color can 
be selected from this dialog. 

Size Transformer 
Button ** 

By clicking the Size Transformer Button the program will 
evaluate the loading on the transformer and suggest a 
different size if the existing transformer is under or over 
loaded. Transformer loading limits are set in the Edit Custom 
Parameters, Transformer, and Data. 

Design Menu Button ** When the Size Transformer button is selected it toggles to 
Design Menu. This allows the user to edit the secondary 
design.  

Deleting a Component To delete a component, select the node (left click) and hit 
the keyboard delete key. When a node is deleted it will also 
delete any associated cable links. Do not leave any stranded 
loads. Execution of calculations with stranded loads may 
cause a program crash. 

** Available in Single Phase SEDS Only 

Voltage Drop Tab 

The Voltage Drop Tab is used to calculate the voltage drop between the source and 

each load. SEDS shows the results of the Voltage Drop calculations underneath each 

load along with the secondary conductor currents. To select the basis for voltage drop 

results display, click the drop-down box on the top middle of the screen. The options 

for this screen are shown in Table 11.3. 
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Table 11.3 Options available on the Voltage Drop Tab 

Options Description 

Select Volt Display There are three different voltage bases to choose from: 
120V, 240V, and %. Selecting one of these options will 
change each load's displayed voltage according to the 
base chosen. The default base is 120 V. However, once the 
program is opened and another base is selected the 
results will stay on the new base until changed again. 

Transformer Results Box 
** 

The transformer results box lists the actual loading on the 
transformer, and the loading limits for the transformer 
selected. The net coincidence factor used to calculate 
transformer loading is also shown in this box. 

Line Current Results ** The line currents shown on the Voltage Drop Tab 
represent the coincidental current for each line segment. 
When overloaded the line changes to red.  

Winter or Summer 
Results 

By clicking on the Show Winter or Show Summer button 
the voltage drop values shown for each load, will change 
to the appropriate seasonal results. 

** Available in Single Phase SEDS Only 

Flicker Tab 

The Flicker Tab is where each load's motor starting current (or other transient current) 

is evaluated for its flicker effects at that service and at other services on the system, 

and at the transformer secondary terminals. Flicker calculation results are shown 

under each of the modeled loads. If the flicker warning limit is exceeded the results 

turn red. The worst-case flicker at the transformer secondary terminal is shown in a 

text box located on the upper right hand part of the screen. The options for the flicker 

tab are shown in Table 11.4. 
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Table 11.4 Options Available on the Flicker Tab 

Options Description 

Flicker Button Select whether self-induced flicker results or worst-case 
mutual flicker results are show on the window. 

Show Self Flicker Flicker induced at each service by a motor at the same 
service. If there is no motor then the self-induced flicker will 
be 0.  

Show Mutual Flicker Worst-case flicker induced at each load by a motor at 
another load or by the motor at the load. The format is 
percent flicker and load name (motor) that caused the 
flicker i.e. .78% N2L1 (Node 2, Load 1) Mutual flicker can will 
consider self-induced flicker if “Include Self” is selected. If 
“Exclude Self” is selected mutual flicker will only consider 
the impact of motors at other services.  

Short Circuit Tab 

The Short-Circuit Tab is used to calculate the available fault current values at each of 

the Loads (service entrances) and at the Transformer Secondary. All calculated short-

circuit values for the loads are shown under their respective loads. Note that the 

primary source impedance is only included in the short-circuit calculations if the user 

specified the impedance value on the Design Tab for the source is selected. 

Detailed Results Tab 

The Detailed Results Tab is a composite of data entered on the Design Tab, and 

calculations done on the Voltage Drop Tab and the Flicker Tab. It is covered in more 

detail in the section Detailed Results Tab. 
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